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DISCLAIMER

This software has been thoroughly tested, however...

DISCLAIMER

( "THE AUTHOR" SHALL MEAN DAVID T. OSSORIO)

THE AUTHOR DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABLITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED, NEITHER THE AUTHOR NOR ANYONE ELSE 
WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE 
SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING 
OUT OF THE USE OF INABILITY TO USE SUCH SOFTWARE EVEN IF THE AUTHOR HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN NO EVENT SHALL THE 
AUTHOR'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO 
USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM.    THE PERSON USING THE 
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

This agreement shall be governed by the laws of the State of Washington and shall inure to the 
benefit of the author, and any successors, administrators, heirs and assigns.    Any action or proceeding 
brought by either party against the other arising out of or related to this agreement shall be brought only 
in a STATE or FEDERAL COURT of competent jurisdiction located in King County, Washington.    The 
parties hereby consent to in personam jurisdiction of said courts. 

Visual C++ and Windows are trademarks of Microsoft Corporation.



Cloning the current matrix
To copy the current matrix, select a matrix in the list box and click the "Okay" button.    The current matrix 
will be copied into the selected matrix.



Getting started with Matrix Lab

Welcome to Matrix Lab 1.0.    Matrix Lab is essentially a calculator that works with matrices instead of 
numbers.    Using Matrix Lab, matrices are easily defined and can be saved to a file, and once defined, 
are easy to work with.    All of the basic matrix operations are supported, including multiplication, 
determinants, inverses, etc.    Matrix elements may be either complex numbers, real numbers, or 
fractions.    With all of these operations, the emphasis is on an easy to use and intuitive interface;    Matrix 
Lab makes working with matrices as painless as possible.

The Matrix Lab Document

A document in Matrix Lab is a set of 16 matrices.    Each matrix is identified by a letter (A-P), and its size 
can be up to eight rows by eight columns.    Also associated with each matrix is a memo field which can 
optionally be used to enter a comment.    Documents are saved and retrieved using the normal File Open 
and File Save commands.    Matrix Lab documents have the extension .mtx.

The Matrix Lab Main Form

The Main Form appears when you start Matrix Lab.    The main list box at the bottom of the screen lists all 
sixteen matrices, along with their sizes and any comments you may have entered for them.    One of the 
sixteen matrices is always selected in the main list box.    Above the main list box are sixty seven edit 
boxes where you can edit the elements of the matrix, it's size, and comments.    Selecting a new matrix in 
the list box automatically fills the edit boxes above with the appropriate information.

See also:    Entering numeric values in the Main Form.

The Current Matrix

Almost all Matrix Lab operations (inverse, determinant, etc.) operate on the Current Matrix.    The Current 
Matrix is simply the matrix represented by the values you have showing on the form at this moment.    For 
example, if you have selected 2 in the Rows and Cols list boxes and have filled in the element edit boxes 
with zero, then the "Current Matrix" is a 2x2 matrix whose entries are all zero.

The Update Button

The Current Matrix is not saved (copied) to the main list box until you click the Update button.    Clicking 
the Update button copies the current matrix into the matrix you have selected in the main list box.    You 
will notice that when you do this the list box is updated with the new row,column and description text you 
have entered. 

The Restore Button

The Restore button simply copies the matrix last saved to the main list box    (with the Update button) into 
the main form , thus making it the current matrix.

The above is all you need to know to get started with Matrix Lab.    Once you have entered a matrix on the 
main form, you can select menu items to perform operations on that matrix (the current matrix).    The 
result of any operation is always displayed on the main form, so you can immediately see the result of a 
matrix computation.



Registration Form 0000-02

This form can be printed by selecting File/Print Topic from the Windows Help menu above.    If you are 
unable to print this from then you can:

1)    Print the ASCII file MATRIXLB.REG (in NOTEPAD, for example)    OR...
2)    Send the information requested below, with payment, to the address given.

--------------------------------------------------------------------------------------------------------------------------------
Matrix Lab Version 1.00 Registration Form

Please Print

Name: _______________________________________________________________________

Address: _________________________________________________________________

City: ___________________________________________    State: ____    Zip _____________

Phone (optional) (______) _______________________ Country: ________________________

Where did you obtain your copy of Matrix Lab?

___________________________________________________________________________

Registration Fee (includes shipping & handling): $35.00 $_____________
Complete Visual C++ Source Code on Disk: (optional) $30.00 $_____________
Note:    a printed copy of the complete source code is included in the $35.00 basic registration fee.

The optional disk includes everything you need to build Matrix Lab using Visual C++ (even the on-line 
help .RTF files!)

Total: $_____________

Disk Size (circle one): 5.25 High Density 3.5 High Density 3.5 Low Density

Company and personal checks are accepted as well as money orders.    The amount shown above is in 
U.S. dollars.    All checks in U.S. funds must be drawn on a U.S. bank.    For uses outside the U.S., checks 
are accepted in your local currency from users in Canada, United Kingdom, Mexico, France, Germany, 
Spain, Japan, The Netherlands, Australia, New Zealand, Sweden, Norway, and Denmark.    (Please send 
U.S. funds if you are able to.    Users in the United States must send U.S. funds).

Please make checks payable to:    David Ossorio
Send To:

David Ossorio
325 S. Washington Ave.    #166
Kent, WA    98032

Thank you for registering!



Site license information

If you plan to use this software on more than one computer, a site license is required.    A site license 
allows internal use and duplication of the software for as many sites or computers as is contracted for.    
This is copyrighted software and any reselling of the software to third parties is prohibited.

Site license rates are negotiable.    For information about purchasing site licenses, call (206) 941-8264.

Or write:

David Ossorio
325 S. Washington Ave.    #166
Kent, WA    98032

See Also:

Benefits of Registration
Registration Form
About Shareware



About Shareware

This software is being distributed as Shareware.    This means that you have a fully functioning copy of 
the software to "try before you buy".    There is an examination period of 30 days.    If after 30 days you are 
still using the software then you must register it.    To register, simply print the Registration Form and send 
it with payment to the indicated address.    If you wish to register this software for more than one 
computer, then see Site License Information. Thus you can find out if the software fully meets your needs 
before you purchase it.    Naturally, you are encouraged to make and distribute as many copies as you 
wish of the mlab100.zip file.

Shareware authors such as myself fully trust that if you find this software useful, you will register it.    We 
believe that the vast majority of people are honest and will pay for software that they use beyond the 30 
day evaluation period.

Please register today!

See Also:

Benefits of Registration



Benefits of registration

When you register this software, you will receive:

[] The right to continue using Matrix Lab.

[] The latest version of Matrix Lab.    You will be assured that any last minute 
improvements/enhancements will be included in the registered version.

[] Free unlimited technical support via phone/fax, mail, or E-Mail for a period of three years.

[] A printed copy of the complete Visual C++ (tm) source code for Matrix Lab (Matrix Lab was written in 
C++ using MFC 2.0).    (Complete source code is also available on disk for an additional fee.)

[] Updates for the price of a disk & postage.

But wait!! That's not all!!

[] No more annoying SHAREWARE reminder screens!

[] Your name appears in the "About" box.

See Also:

About Shareware
Registration Form



How To ...
Create a matrix
Edit matrix entries

            Find the determinant of the current matrix
Add, Subtract, or Multiply matrices
Multiply the current matrix by a real or complex scaler
Find the conjugate of the current matrix
Find the inverse of current matrix
Row-reduce the current matrix
Find the transpose of the current matrix
Fill the current matrix with zeros
Set the current matrix to the identity matrix



How to create a matrix

To create a matrix, simply select the number of rows and columns from the Rows and Columns list box. 
You may then edit the matrix elements (that is, enter the numbers which form the matrix).    Click the 
Update button to copy the matrix to the matrix list box.    Select Save or Save As from the file menu to 
save all sixteen matrices in the matrix list box to a disk file.



How to edit matrix entries

Matrix elements may be fractions, real numbers, or complex numbers. 

Fractions

To enter a fraction as a matrix element, simply type the numerator followed by a slash ('/') and then the 
denominator.    Both the numerator and denominator must be integers.    Here are some examples of legal 
fractions in Matrix Lab:

1/2
0/3
3465/10983
34 / 54
0 / 1
(note that spaces are ignored)

Fractions are automatically reduced.    For example, if you enter 6/8 as an element in the current matrix, 
when you update the current matrix or perform any matrix operation on it, this is changed to 3/4.

The only restriction on fractions is the numerator and denominator must be real integers in the range  -
(2^31) to (2^31)-1.

Real Numbers

Real numbers are entered as you normally would in a calculator.    Here are some examples of legal real 
numbers:

1
2e10
3.43
-0.10

If a real number does not have any digits after the decimal point and is small enough to be represented 
by a signed long integer, then it is automatically converted to a fraction type, so entering 7, for example, is 
equivalent to entering 7/1.    If you want to force floating point computations, then you can enter 7.0.

Complex numbers

Complex numbers are identical to real numbers except that they are entered in pairs.    The real part of 
the number is separated by the imaginary part with a comma.    Here are some examples of legal complex 
numbers:

1,-1 ( 1 - 1i)
0,-1 ( 0 - 1i)
3.65,0.34e10 (3.65 + 34e10i)
0,0 (0 + 0i)

Alternatively, you can enter a complex number using the usual a+bi notation.    The only restriction is that 
if you use this syntax you must enter values for both a and b, followed by the letter i.    Formally, the 
syntax is:

a [+|-] bi, where a and b are real numbers.

For example,



3+1i (valid)
3+i (not valid)

0-4i (valid)
4i (not valid)
0-4 (not valid)
0+-4i (not valid)

Internally, Matrix Lab treats real numbers as complex numbers with the imaginary part equal to 0.0, so 
there are really only two matrix element types.

Note that for large matrices (7x7 or above), or matrices with large numerical entries, you may have to use 
real number entries if you are going to be computing a determinant or inverse (but see the warning 
below).    The reason for this is that since fractions are stored as integers, they can easily overflow when 
multiplied together.    Matrix Lab will warn you if integer overflow has occurred and prompt you repeat the 
selected operation using floating point (Real or Complex) numbers.

Note also that when using complex numbers with both real and imaginary parts, floating point roundoff 
error can accumulate fairly rapidly when performing certain operations such as computing inverses for 
large matrices, since these operations can require tens of thousands of individual floating point 
computations.    Roundoff error does not seem to be as much of a problem when real numbers are used 
(that is, imaginary part = 0.0).    Unfortunately, nothing could be done about this in the current release of 
Matrix Lab.
(Matrix Lab will use a floating point coprocessor if you have one (I don't), so in that case roundoff error 
might be less of a problem).

See Also:    Rules for combining matrix elements.



Rules for combining matrix elements

When performing matrix calculations (addition, multiplication, determinant, row reduction, etc.), Matrix Lab 
combines elements as follows:    (where @ is a binary operator such as multiplication, addition, or 
subtraction)

Fraction @ Fraction = Fraction
Fraction @ Complex/Real = Complex/Real
Complex/Real @ Fraction = Complex/Real
Complex/Real @ Complex/Real = Complex/Real

You can see that only if both elements are fractions will the result of a computation be a fraction.    
Therefore, it is best to make all elements in a matrix fractions if at least one of them is a fraction.



How to find the determinant the current matrix

To find the determinant of the current matrix, click the Determinant Toolbar button  or select 
Determinant from the operations menu.



Almost all Matrix Lab operations (inverse, determinant, etc.) operate on the Current Matrix.    The Current 
Matrix is simply the matrix represented by the values you have showing on the form at this moment.    For 
example, if you have selected 2 in the Rows and Cols list boxes and have filled in the element edit boxes 
with zero, then the "Current Matrix" is a 2x2 matrix whose entries are all zero.



How to add, subtract or multiply two matrices

To add, subtract, or multiply two matrices together, simply click the appropriate Toolbar button  

 

 or select from the math menu.

A dialog box will be displayed prompting you for the first and second arguments.    The result is always 
displayed in the main form (and becomes the current matrix.).



How to multiply the current matrix by a scalar

To multiply the current matrix by a scalar, simply select that operation from the Math menu.    A dialog box 
will be displayed prompting you for the scalar.    Each element of the current matrix will be multiplied by 
the scalar you enter here, which can be a fraction, real, or complex number.

For the syntax of entering the scalar in the dialog box, see:
How to edit matrix entries



How to find the conjugate of the current matrix

To find the conjugate of the current matrix, simply click the conjugate Toolbar button , or select 
Conjugate from the operations menu



How to find the inverse of a matrix

To find the inverse of the current matrix, simply click the inverse Toolbar button  or select Inverse 
from the operations menu

If the determinant of the current matrix is zero, a message box will display informing you that the current 
matrix does not have an inverse.



How to row reduce the current matrix

Matrix Lab defines three types of row reduction:

Row Reduce

Selecting Row Reduce from the operations menu will change the current matrix, using elementary row 
operations, as follows:

The number of zero's preceding the first non zero entry of a row increases or remains the same 
row by row until only zero rows remain (if there are any zero rows).    This is usually defined as row 
echelon form, however, Matrix Lab uses that definition only if all leading entries are 1.
Here are a few examples of row reduced matrices:

3 2 0 5 2 3 3 4 5
0 1 2 3 0 5 0 0 4
0 0 1 1 0 0 1
0 0 0 0

Row Echelon Reduce

Selecting Row Echelon Reduce from the operations menu will first Row Reduce the current matrix as 
described above, and then change the leading non-zero entries to 1 using elementary row operations. 
Here are a few examples of row echelon reduced matrices:

1 2 0 5 1 3 1 4 5
0 1 2 3 0 1 0 0 1
0 0 1 1 0 0 0
0 0 0 1

Row Canonical Reduce

Selecting Row Canonical Reduce from the operations menu will first Row Echelon Reduce the current 
matrix as described above, and then change the entries above the leading 1's to zeros using elementary 
row operations.
Here are a few examples of row canonical reduced matrices:

1 0 0 5 1 0 0 1 0 0 4
0 1 0 4 0 1 0 0 0 1 3
0 0 1 5 0 0 1 0 0 0 0



How to find the transpose of the current matrix

To find the transpose of the current matrix,simply click the Transpose Toolbar button  , or select 
Transpose from the operations menu



How to fill the current matrix with zeros

To change the current matrix into the zero matrix (fill will zero's), click the Fill Zero Toolbar button  , 
or select Fill Zero from the operations menu 



How set the current matrix to the identity matrix

To change the current matrix into the identity matrix, click the Fill Identity Toolbar button  , or select 
Fill Identity form the operations menu



 Commands
File menu
Edit menu
View menu
Matrix menu
Operations menu
Math menu
Window menu
Help menu



Definition of Row Echelon Form

In Matrix Lab, a matrix is in Row Echelon Form if and only if:

1) The number of leading zeros increases or stays the same row by row until only zero rows 
remain (if there are any zero rows).

2) The leading non-zero entries of each row are 1.

Examples:

1 2 0 5 1 3 1 4 5
0 1 2 3 0 1 0 0 1
0 0 1 1 0 0 0
0 0 0 1



Row Canonical Form

In Matrix Lab, a matrix is in Row Canonical Form if and only if:

1) It is in row echelon form
2) For each non-zero leading entry, there are zero entries directly above it.

Examples:

1 0 0 5 1 0 0 1 0 0 4
0 1 0 4 0 1 0 0 0 1 3
0 0 1 5 0 0 1 0 0 0 0



Matrix menu commands

The Matrix menu offers the following commands:

Set Undefined Sets the current matrix to an undefined state.
Clone Copies the current matrix to a selected matrix record.
Update Transfers the current matrix to the selected matrix record.
Restore Transfers the last updated matrix to the current matrix.
Convert to floating point Converts any fraction (integer) elements in the current matrix to floating 

point complex elements.
Convert to fraction Converts any floating point elements in the current matrix to fraction 

(integers). 
Set Undefined Command (Matrix menu)

Use this command to set the current matrix to an undefined state.

Shortcuts
Keys: CTRL+SHIFT+U



Clone (Matrix menu)

Use this command to copy the current matrix to another matrix.

Shortcuts
Keys: CTRL+L



Update (Matrix menu)

Use this command to copy the current matrix to the matrix selected in the matrix list box.

Shortcuts

Main Form: Update button
Keys: CTRL+U



Restore (Matrix menu)

Use this command to restore the matrix last saved with the Update command to the current matrix.

Shortcuts
Main Form: Restore button
Keys: CTRL+R



Convert to Floating Point (Matrix menu)

Use this command to change each element of the current matrix into a complex/real number.    If an 
element is already a complex/real number, then it is unchanged.

Shortcuts
Keys: CTRL+P



Convert to Fraction (Matrix menu)

Use this command to change each element of the current matrix into a fraction.    If an element is 
complex/real, then it will only be converted to a fraction if it is a non-zero integer in the range -(2^31) to 
(2^31)-1.

Shortcuts
Keys: CTRL+F



Math menu commands

Add Adds two matrices together.
Subtract Subtracts two matrices.
Multiply Multiplies to matrices together.
Multiply by a scaler Multiplies the current matrix by a scalar.
Add (Math menu)

Use this command to add two matrices together.    The result of the addition is always display in the main 
form (and becomes the current matrix.)

Shortcuts

Toolbar:
Keys CTRL+A



Subtract (Math menu)

Use this command to subtract two matrices. The result of the subtraction is always display in the main 
form (and becomes the current matrix.)

Shortcuts

Toolbar:
Keys CTRL+B



Multiply (Math menu)

Use this command to multiply two matrices together.    The result of the multiplication is always display in 
the main form (and becomes the current matrix.)

Shortcuts

Toolbar:
Keys CTRL+M



Multiply by a Scalar

Use this command to multiply the current matrix by a scalar.    Each element of the current matrix will be 
multiplied by the number specified in the dialog box.

Shortcuts
Keys: CTRL+SHIFT+M



Operations menu commands

The Operations menu offers the following commands:

Fill Identity Sets the current matrix to the identity matrix.
Fill Zero Sets the current matrix to the zero matrix.
Negate Negates the current matrix
Transpose Transposes the current matrix
Row Reduce Row reduces the current matrix.
Row Echelon Reduce Reduces the current matrix to row echelon form.
Row Canonical Reduce Reduces the current matrix to row canonical form.
Inverse Computes the inverse of the current matrix
Determinant Computes the determinant of the current matrix
Conjugate Computes the conjugate of the current matrix



Fill Identity (Operations menu)

Use this command to change the current matrix into the identity matrix.

Shortcuts

Toolbar:
Keys: CTRL+Y



Fill Zero (Operations menu)

Use this command to set the current matrix to the zero matrix.

Shortcuts

Toolbar:
Keys: CTRL+E



Negate (Operations menu)

Use this command to compute the negative of the current matrix.

Shortcuts

Toolbar:
Keys: CTRL+G



Transpose (Operations menu)

Use this command to compute the transpose of the current matrix.

Shortcuts

Toolbar:
Keys: CTRL+T



Row Reduce (Operations menu)

Use this command to row reduce the current matrix.

Shortcuts
Keys: F2



Row Echelon Reduce (Operations menu)

Use this command to reduce the current matrix to row echelon form.
Shortcuts

Keys: F3



Row Canonical Reduce (Operations menu)

Use this command to reduce the current matrix to row canonical form.

Shortcuts

Keys: F4



Inverse (Operations menu)

Use this command to find the inverse of the current matrix.

Shortcuts

Toolbar:
Keys: CTRL+I



Determinant (Operations menu)

Use this command to find the determinant of the current matrix.

Shortcuts

Toolbar:
Keys: CTRL+D



Conjugate (Operations menu)

Use this command to find the conjugate of the current matrix.

Shortcuts

Toolbar:
Keys: None.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Exit Exits Matrix Lab.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the currently selected edit box and moves it to 

the clipboard.
Copy Copies data from the currently selected edit box to the clipboard.
Paste Pastes data from the clipboard into the currently selected edit box.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of Matrix Lab.



New command (File menu)

Use this command to create a new document in Matrix Lab. 
You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
Matrix Lab always creates files with the extension .mtx

Drives
Select the drive in which Matrix Lab stores the file that you want to open. 

Directories
Select the directory in which Matrix Lab stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    Matrix Lab suggests that you 
save changes to your document before you close it.    If you close a document without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled document, Matrix Lab displays 
the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, Matrix Lab displays the Save As dialog box so you can name your document. 
If you want to change the name and directory of an existing document before you save it, choose the 
Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Matrix Lab displays the Save As dialog box 
so you can name your document. 

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Matrix Lab adds the extension you specify in 
the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Matrix Lab session.    You can also use the Close command on the 
application Control menu.    Matrix Lab prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the currently selected edit box and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Matrix Lab, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Matrix Lab,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    Matrix Lab displays the Open dialog box, in which you can locate 
and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, Matrix Lab displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Fill the current matrix with zeros.

Change the current matrix into the identity matrix.

Negate the current matrix.

Transpose the current matrix.

Find the inverse of the current matrix.

Find the determinant of the current matrix.

Find the conjugate of the current matrix.

Add two matrices together.

Subtract two matrices.



Multiply two matrices together.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Matrix Lab window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

Matrix Lab displays a list of currently open document windows at the bottom of the Window menu.    A 
check mark appears in front of the document name of the active window.    Choose a document from this 
list to make its window active. 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Matrix Lab and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Matrix Lab.



Context Help command 

Use the Context Help command to obtain help on some portion of Matrix Lab.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Matrix Lab window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Matrix Lab window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Matrix Lab determines which window is 
next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Matrix Lab determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the main window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying the Document
See Getting started with Matrix Lab



Overflow

An integer calculation has overflowed.    You should repeat the selected matrix operations using 
real/complex numbers.



Bad file format

The file which you attempted to open was not created with Matrix Lab or has been corrupted.



No inverse help

Matrices with determinants equal to zero (singular) do not have inverses).



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



A document in Matrix Lab is a set of 16 matrices.    Each matrix is identified by a letter (A-P), and its size 
can be up to eight rows by eight columns.    Also associated with each matrix is a memo field which can 
optionally be used to enter a comment.    Documents are saved and retrieved using the normal File Open 
and File Save commands.    Matrix Lab documents have the extension .mtx.



Scalar Multiplication

Enter a number in the Edit Box exactly as you would in the main form (this can be a fraction, real, or 
complex number).    Each element of the current matrix will be multiplied by the number entered.

See Also:

Editing numbers



Operators

To add, subtract, or multiply two matrices together:

1) Select the 1st matrix in the "operator 1" edit box.
2) Select the operator (+, -, or *).
3) Select the 2nd matrix in the "operator 2" edit box.

The result of the computation is always placed in the main form and becomes the current matrix.

For example, if you select A in the operator 1 edit box and C in the operator 2 edit box and the '+' 
operator, the A+B is displayed in the main form.




